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Preface
The Quartus® II Installation & Licensing for UNIX and Linux Workstations 
manual provides comprehensive information for installing and licensing the 
Quartus II software and related software; includes additional workstation 
configuration information that allows you to properly configure a 
workstation for use with the Quartus II software; and includes information 
about other documentation and technical support.
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Documentation Conventions
The Quartus II Installation & Licensing for UNIX and Linux Workstations 
manual uses the following conventions to make it easy for you to find and 
interpret information.

Typographic Conventions

Quartus II documentation uses the typographic conventions shown in the 
following table:

Visual Cue Meaning

Bold Initial 
Capitals

Command names; dialog box, page, and tab titles; and button names 
are shown in bold with initial capital letters. For example: Find Text 
command, Save As dialog box, and Start button.

bold Directory, project, disk drive, file, software utility, and software 
executable names; software utility names; and options in dialog 
boxes are shown in bold. For example: quartus directory, d: drive, 
and license.dat file.

Initial Capitals Keyboard keys, user-editable application window fields, windows, 
views, and menu names are shown with initial capital letters. For 
example: Delete key and the Options menu.

“Subheading 
Title”

Subheadings within a manual section are enclosed in quotation 
marks. In manuals, titles of Help topics are also shown in quotation 
marks. For example: For more information, see “Exporting and 
Importing Version-Compatible Database Files” in Quartus II Help.

Italic Initial 
Capitals

Help categories, manual titles, section titles in manuals, and 
application note and brief names are shown in italics with initial 
capital letters. For example: FLEXlm End Users Guide.

italics Variables are enclosed in angle brackets (< >) and shown in italics. 
For example: <file name> and <DVD-ROM drive>.

Courier font Anything that must be typed exactly as it appears is shown in 
Courier. For example: \quartus\bin\lmutil lmhostid.

r Enter or return key.

■ Bullets are used in a list of items when the sequence of the items is 
not important.

v The checkmark indicates a procedure that is one step only.

! The hand points to information that requires special attention.
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Terminology

The following table shows terminology that is used throughout this manual:

f The feet show you where to go for more information on a particular 
topic.

w The exclamation mark points to information or action that you take 
that can cause harm to your computer or cause you to lose data.

Visual Cue Meaning

Term Meaning

click Indicates a quick press and release of the left mouse button. 
Also indicates that you need to use a mouse or key combination 
to start an action.

double-click Indicates two clicks in rapid succession.

select Indicates that you must highlight text and/or objects or an 
option in a dialog box with a key combination or the mouse. A 
selection does not start an action. For example: Select Chain 
Description File, and then click OK.

point Indicates that you must position the mouse pointer, without 
clicking, at an appropriate location on the screen, such as a 
menu or submenu. For example: On the Help menu, point to 
Altera on the Web, and then click Quartus II Service 
Request.

turn on/turn off Indicates that you must click a check box to turn a function on 
or off.
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Introduction
This chapter describes the requirements and procedures for installing the 
Quartus II software and related software, which is available from the 
Download Center of the Altera website, and the Altera Complete Design 
Suite for UNIX and Linux, which is available by request on a DVD-ROM.

You can download the following software from the Download Center of the 
Altera website:

UNIX Workstations (Solaris 8 and 9; 32-bit and 64-bit)

■ Quartus II Subscription Edition Software v8.0 for UNIX Workstations 
(includes device information and IP Library)

■ ModelSim-Altera v6.1g for Quartus II v8.0 for UNIX Workstations

Linux Workstations (Red Hat Enterprise Linux 3.0 and 4.0 and SUSE Linux 
Enterprise Server 9; 32-bit and 64-bit)

■ Quartus II Subscription Edition Software v8.0 for Linux Workstations 
(includes device information and IP Library)

■ ModelSim-Altera v6.1g for Quartus II v8.0 for Linux Workstations 
■ Nios II Embedded Design Suite for Linux Workstations

The Altera Complete Design Suite for UNIX and Linux version 8.0 
DVD-ROM includes all of the software in the preceeding lists.

Quartus II Software System 
Requirements

Your system must meet the following minimum requirements:

Hardware

■ One of the following workstations:
– Sun Ultra workstation with 256 MB of system memory running 

Solaris version 8 or 9 (for 32-bit and 64-bit Solaris workstations).
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– Intel Pentium III or compatible processor-based PC operating at 
450 MHz or faster with 256 MB of system memory, running Red 
Hat Enterprise Linux 3.0 or 4.0 or SUSE Linux Enterprise Server 9 
(for 32-bit Linux workstations).

– 32-bit Linux workstations are capable of running the 32-bit version 
of the Quartus II software with access to virtual memory of up to 
4 GB. If your Quartus II project requires addressability of virtual 
memory greater than 4 GB, you must use the 64-bit version of the 
Quartus II software on a 64-bit Linux workstation.

– AMD64 processor or Intel EM64T processor or compatible 
processor-based PC with 1 GB memory, running Red Hat 
Enterprise Linux 3.0 or 4.0 or SUSE Linux Enterprise Server 9 (for 
64-bit Linux workstations).

■ Adequate disk space, as described in the readme.txt file, which is 
located in the top-level directory of the Altera Complete Design Suite 
DVD-ROM. After installation, the readme.txt file is available from the 
Quartus II Help menu and in the Altera Complete Design Suite system 
directory.

■ ISO 9660–compatible DVD-ROM drive (DVD-ROM installation only).
■ Color monitor.

Cables and Ports

■ 10/100 Mb Ethernet connection for connecting anEthernetBlaster 
download cable.

■ Serial port for connecting a MasterBlaster™ communications cable.
■ USB port for connecting a USB-Blaster™ download cable (Linux 

workstations only).
■ Parallel port for connecting a ByteBlasterMV™ parallel port download 

cable (Linux workstations only).

Software

■ One of the following window managers:
– Sun Solaris workstations: dtwm, vuewm, mwm, or olwm.
– Linux workstations: kde or gnome (must be the version that is 

included with Red Hat Enterprise Linux 3.0 or 4.0 or SUSE Linux 
Enterprise Server 9).

■ The native XServer software for Linux and Solaris platforms, which is 
required when running the Quartus II software.

■ A web browser with an Internet connection is required for using 
Quartus II software Internet resources. Firefox, version 2.0 or later, or 
Microsoft Internet Explorer browser, version 5.0 or later, is required.
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■ One of the following Flash Players, for use of the Quartus II Interactive 
Tutorial:
– Sun Solaris workstations: Flash Player 7.0 with Mozilla 1.4 or 1.7 

(Solaris version 8 or 9).
– Linux workstations: Flash Player 7.0 with Mozilla 1.2 or later (Red 

Hat Enterprise Linux 3.0 or 4.0 or SUSE Linux Enterprise Server 9).

f For Information About Refer To

Specific disk space and memory 
requirements

The readme.txt file, which is located in the 
top-level directory of the Altera Complete 
Design Suite DVD-ROM. After installation, 
the readme.txt file is available from the 
Quartus II Help menu and in the Quartus II 
system directory

Updated information about system 
requirements and the most current 
version of this manual

Quartus II Installation & Licensing for UNIX 
and Linux Workstations manual on the 
Altera website

Latest information on new features, 
EDA interface support, and known 
issues and workarounds for the 
Quartus II software

Quartus II Software Release Notes 
document on the Altera website

Latest information about device 
support for the Quartus II software

Quartus II Device Support Release Notes 
document on the Altera website

Quartus II software features and how 
they work with your design flow

Introduction to Quartus II Software manual 
on the Altera website and the Quartus II 
Interactive Tutorial. After installation, the 
Quartus II Interactive Tutorial is available 
from the Quartus II Help menu and in the 
Quartus II system directory

Altera programming hardware ByteBlaster II Download Cable User Guide, 
ByteBlasterMV Download Cable User Guide, 
EthernetBlaster Download Cable User 
Guide, MasterBlaster Serial/USB 
Communications Cable User Guide, and 
USB-Blaster Download Cable User Guide on 
the Altera website



CHAPTER 1: INSTALLING THE QUARTUS II SOFTWARE

UNINSTALLING PREVIOUSLY INSTALLED VERSIONS OF ALTERA SOFTWARE

ALTERA CORPORATION INSTALLATION & LICENSING FOR UNIX AND LINUX ■ 5

Uninstalling Previously Installed 
Versions of Altera Software

If you want, you can uninstall a previous version of the Quartus or 
Quartus II software before installing the current version of the Quartus II 
software.

To uninstall a previous version of the Quartus or Quartus II software, delete 
the Quartus II system directory (default name is quartus).

Altera.com Website Download 
Center

You can download the following items from the Download Center of the 
Altera website:

■ Quartus II software and related software listed in “Introduction” on 
page 2

■ Altera Edition third-party software
■ License daemons
■ Intellectual property (IP) and tools
■ Altera University Program software
■ Altera Legacy Design software
■ Programming software
■ Altera board layout and test files

The Quartus II software for UNIX and Linux, and related software, uses a 
text-based installation script to install each software downloaded from the 
Download Center of the Altera website and automatically guides you 
through the installation process.
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Installing Downloaded Altera 
Software

You should be aware of the following information before you install the 
Quartus II software and related software:

■ Commands that do not fit on a single line in this manual are indicated 
by indentations of subsequent lines.

■ The UNIX environment is case sensitive. You must type directory 
names, file names, and file name extensions exactly as shown.

■ By default, the Quartus II software, and related software, is installed in 
the /opt/altera<version number> directory, where <version number> is 
the number of the Quartus II software version directory. The 
installation procedure creates this directory, if it does not already exist. 
If you use a different directory name, substitute the appropriate name 
for <Quartus II system directory> in the installation steps.

■ Ensure there is at least approximately 4 GB of free disk space to contain 
copies of the uncompressed versions of the installation files. An 
additional 5 GB of disk space is required for software installation.

■ To run the Quartus II software using a network (multiuser) license, 
make sure that the license server uses version 8.0 or later of the FLEXlm 
License Manager Server software. By default, the Quartus II software 
installs version 9.5 of the FLEXlm License Manager Server software on 
the user workstation. For more information, refer to “Upgrading or 
Setting Up a License Manager Server” on page 21.

■ If you want to preserve project compilation databases from an earlier 
version of the Quartus II software before installing a newer version, 
Altera recommends that you open the design in the earlier version of 
the software and export a version-compatible database for the design 
by clicking Export Database on the Project menu. After you have 
installed a newer version of the Quartus II software, you can import the 
database in the new version by clicking Import Database on the Project 
menu. For more information about importing and exporting version-
compatible databases, refer to the Managing Quartus II Projects chapter 
in volume 2 of the Quartus II Handbook. Version-compatible database 
files are available in Quartus II software version 4.1 and later.
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To install downloaded Quartus II software and related software on a Solaris 
or Linux workstation, follow these steps:

1. Download the software listed in “Introduction” on page 2 from the 
Download Center of the Altera website.

2. Verify that you have sufficient free disk (approximately 4 GB) to 
contain copies of uncompressed versions of the software files.

3. To extract the Quartus II software, type the following command at the 
command prompt:

tar xvf 80_quartus_<operating system name>tar r

where <operating system name> can be solaris or linux.

4. To execute the installation script, type the following command at the 
command prompt:

<Quartus II system directory>/<operating system>/install r

You are guided through the installation procedure.

5. Repeat steps 1 through 4 for each downloaded software you want to 
install.

Altera Complete Design Suite
The Altera Complete Design Suite for UNIX and Linux version 8.0 includes 
an integrated software installation solution that allows you to install the 
Quartus II software and related software from one application or 
DVD-ROM, which is available by request.

The Altera Complete Design Suite for UNIX and Linux uses a text-based 
installation script that allows you to select the software you want to install 
and automatically guides you through the installation process.

You can choose to perform a normal or custom installation. A normal 
installation automatically installs all of the software included in the Altera 
Complete Design Suite using default settings and all program features. A 
custom installation allows you to select which software you want to install.
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The Altera Complete Design Suite for UNIX and Linux installation script 
flow is shown in Figure 1.

Figure 1. Altera Complete Design Suite Installation Flow
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The Altera Complete Design Suite 
Installation Script

The Altera Complete Design Suite installation script installs the Quartus II 
software and related software.

You should be aware of the preinstallation information described in 
“Installing Downloaded Altera Software” on page 6 before you install the 
Altera Complete Design Suite software.

Installing the Altera Complete 
Design Suite on Solaris 
Workstations

You can install the Altera Complete Design Suite software on Sun Ultra 
workstations running Solaris 8 or 9.

To install the Altera Complete Design Suite software on a Solaris 
workstation, follow these steps:

1. Insert the Altera Complete Design Suite for UNIX and Linux 
version 8.0 DVD-ROM into your DVD-ROM drive.

2. Mount the DVD-ROM. For information about mounting DVD-ROMs 
on Solaris workstations, refer to “Mounting and Unmounting 
DVD-ROMs on Solaris Workstations” on page 54 in Appendix B.

3. To install the Altera Complete Design Suite, type the following 
command at the command prompt:

! Before You Install the Altera Complete Design Suite

You must have superuser or “root” privileges to mount and unmount the DVD-ROM 
drive. If you are running Volume Manager, the DVD-ROM drive is mounted and 
unmounted automatically as /dvdrom/dvdrom0 (you do not need to have root 
privileges to mount a DVD-ROM with the Volume Manager), and you need to perform 
only steps 1, 3, 5, and 6 and can skip the other steps.
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/dvdrom/dvdrom0/install r

You are guided through the installation procedure.

4. Unmount the DVD-ROM. For information about unmounting 
DVD-ROMs on Solaris workstations, refer to “Mounting and 
Unmounting DVD-ROMs on Solaris Workstations” on page 54 in 
Appendix B.

Installing the Altera Complete 
Design Suite on Linux Workstations

You can install the Altera Complete Design Suite on Linux workstations 
running Red Hat Enterprise Linux 3.0 or 4.0 or SUSE Linux Enterprise 
Server 9.

To mount the DVD-ROM drive and install the Altera Complete Design Suite 
and device information on a Linux workstation, follow these steps:

1. Insert the Altera Complete Design Suite for UNIX and Linux 
version 8.0 DVD-ROM into your DVD-ROM drive.

2. Mount the DVD-ROM into your DVD-ROM drive. For information 
about mounting DVD-ROMs on Linux workstations, refer to 
“Mounting and Unmounting DVD-ROMs on Linux Workstations” on 
page 55 in Appendix B.

3. To install the Altera Complete Design Suite, type the following 
command at the command prompt:

/mnt/dvdrom/install r

You are guided through the installation procedure.

! Before You Install the Altera Complete Design Suite

You must have superuser or “root” privileges to mount and unmount the DVD-ROM 
drive. If you are logged in on a console, you do not need to have root privileges to 
mount a DVD-ROM.
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4. Unmount the DVD-ROM drive. For information about unmounting 
DVD-ROMs on Linux workstations, refer to “Mounting and 
Unmounting DVD-ROMs on Linux Workstations” on page 55 in 
Appendix B.

Using the 64-bit Version of the 
Quartus II Software on Solaris or 
Linux Workstations

If your project requires addressability of computer memory greater than 
4 GB for the quartus_map, quartus_fit, quartus_sta, quartus_tan, and 
quartus_cdb executables, you can use a 64-bit version of the Quartus II 
software for Solaris or Linux workstations. Compiling designs with the 
64-bit version of the Quartus II software requires more system memory. You 
may notice an increase in compilation times if there is not sufficient physical 
memory to accommodate the increased memory usage. You can mitigate 
this effect by increasing the total physical memory on the system.

When you install the Quartus II software, the 64-bit version of the Quartus II 
software is also installed automatically.

To turn on 64-bit processing in the Quartus II software, follow these steps:

1. Start the Quartus II software as described in the “Starting the Quartus II 
Software” on page 29.

2. On the Tools menu, click Options.

3. In the Category list, select Processing under General.

4. If you want to turn on 64-bit processing in the Quartus II software, 
select Always use 64-bit processing.

w Availability of 64-bit Processing Controls on 32-bit Systems

If the host system does not support 64-bit processing, the controls in the 
Processing page of the Options dialog box in the Quartus II software that turn on 
or off 64-bit processing are not available.
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You can also turn on 64-bit processing using other methods:

■ To turn on 64-bit processing using the QUARTUS_64BIT environment 
variable, refer to “QUARTUS_64BIT” on page 41. 

■ To turn on 64-bit processing using the --64bit option, refer to “Other 
Workstation Configuration Information” on page 42. Be aware that the 
Always use 32-bit processing or Always use 64-bit processing options 
in the Processing page override the settings specified with the 
QUARTUS_64BIT environment variable or the --64bit option.
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Introduction
This section describes how to license the Quartus II software and related 
software. To set up your license for the Quartus II software, you must follow 
these steps, which are described in more detail in this chapter:

1. Obtain a license file. The Quartus II software requires a license.dat 
license file for each server that supports a valid, unexpired network 
(multiuser) license or for each node-locked (single-user) license. This 
same license file can also enable the additional Altera synthesis and 
simulation tools included with Altera software subscriptions, as well as 
the MAX+PLUS II software.

2. If you have a network license (FLOATALL or ADD-FLOATALL), 
modify the license file.

3. Set up and configure the FLEXlm license manager server for a UNIX or 
Linux workstation.

4. Configure each workstation.

5. Configure each Quartus II user’s environment.

6. Start the Quartus II software.

7. Specify the location of the license file.

8. Specify a web browser.

9. Register for an Altera.com account. (Optional)
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Obtaining a License File
When you start the Quartus II software, if the software cannot detect a valid 
license file, you are asked whether you want to run in evaluation mode for 
30 days, perform an automatic license retrieval from the Altera website, or 
specify the correct location of a valid license file.

You can also obtain a license file, license.dat, from the Licensing section of 
the Altera website at www.altera.com/licensing if you have the following 
information:

■ Your Altera ID, which is a six-digit number that is provided when you 
purchase the Quartus II software. If you request the Altera Complete 
Design Suite for UNIX and Linux Version 8.0 DVD-ROM, you can find 
this number on the packing list that is shipped with the software. You 
can also obtain your Altera ID from the mySupport website at 
www.altera.com/mysupport.

■ The license server host ID number for UNIX or Linux network license 
servers. To find your UNIX or Linux network license server host ID 
number with FLEXlm utilities, type the following command at a 
command prompt (where <operating system name> represents linux or 
solaris):

<Quartus II system directory>/<operating system name>/lmutil 
lmhostid r

f For Information About Refer To

Additional methods of finding your 
host ID number

Altera website at www.altera.com

! Saving Previous license.dat Files

Altera recommends that you save any previous license.dat file in a temporary 
directory, in case you need to refer to it later.
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To obtain a license file, follow these steps:

1. Start the Quartus II software as described in the “Starting the Quartus II 
Software” on page 29.

2. Select Perform automatic web license retrieval to request a valid 
license file automatically from the Altera website. You are guided 
through the licensing procedure.

or

To request a license file at a later time, visit the Altera Software 
Licensing page at www.altera.com/licensing.

3. If you are using a network (multiuser) license, type your license server 
host ID.

4. Specify the requested information.

5. Specify the location of your license file. You will receive an e-mail from 
Altera with a license.dat file attached, as well as the license file text. 
You can either use the attached license file, or copy the lines from the 
attached license file to an existing license file. When you receive the 
license file text, save it in the /usr/local/flexlm/licenses directory. If you 
are using your license.dat file with both the Quartus II software and the 
MAX+PLUS II software, Altera recommends that you save it in a 
top-level directory named flexlm.

Figure 1 and Figure 2 show sample network license files for UNIX and Linux 
workstations that function as a single license server.
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Figure 1. Sample Network License File for a Single UNIX Workstation 
Server

Figure 2. Sample Network License File for a Single Linux Workstation 
Server

SERVER alice 807f1034 1800
VENDOR alterad "/opt/altera/quartus80/solaris/alterad"
USE_SERVER
FEATURE altera_mainwin alterad 2008.12 permanent 5 391A92407D4B SIGN="0191 120C \ 

BB64 BC39 E5C8 EBBB 7894 E064 D348 61CC 5C6F 16DD 1269 F246 D07E 19C8 CAE3 \ 
E3E3 6965 E38D 1452 BB74 20E9 E6F6 5718 89AC 0E23 B5B2 1581 E453"

FEATURE quartus alterad 2008.12 permanent 5 7A496D25A602 SIGN="1C66 DAC6 1DAB C886 \ 
727B 65DF FAC2 B479 3E3C 656D 3561 E5D0 BBA3 C45C 4DDC 0F2F 68F5 4DF1 6F63 \ 
7785 2F5D 1480 1B0A 70DE 2220 1952 DDCD 9F4D 6D61 A177"

Optional port 
number

Authorization 
code

Number of 
licenses 
requested

Server 
name

Server 
host ID 
number

Feature 
name

Daemon 
name

Release 
date

Expiration 
date

SERVER alice 807f1034 1800
VENDOR alterad "/opt/altera/quartus80/linux/alterad"
USE_SERVER
FEATURE altera_mainwin_lnx alterad 2008.12 permanent 5 391A92407D4B SIGN="0191 \ 

120C BB64 BC39 E5C8 EBBB 7894 E064 D348 61CC 5C6F 16DD 1269 F246 D07E 19C8 \ 
CAE3 E3E3 6965 E38D 1452 BB74 20E9 E6F6 5718 89AC 0E23 B5B2 1581 E453"

FEATURE quartus alterad 2008.12 permanent 5 7A496D25A602 SIGN="1C66 DAC6 1DAB C886 \ 
727B 65DF FAC2 B479 3E3C 656D 3561 E5D0 BBA3 C45C 4DDC 0F2F 68F5 4DF1 6F63 \ 
7785 2F5D 1480 1B0A 70DE 2220 1952 DDCD 9F4D 6D61 A177"

Optional port 
number

Authorization 
code

Number of 
licenses 
requested

Server 
name

Server 
host ID 
number

Feature 
name

Daemon 
name

Release 
date

Expiration 
date
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If you are using the Quartus II software with a node-locked (single-user) 
license, skip to “Configuring Each Workstation” on page 25. 

The FLEXlm licensing scheme also allows you to set up three redundant 
license servers to serve a network (multiuser) license. You can obtain a 
license file for redundant servers by performing the steps described earlier 
in this section for obtaining a license file. Figure 3 shows a sample redundant 
server license file.

Figure 3. Sample Redundant Server License File

SERVER alice 807f1043 1800
SERVER king 807f1042 1800
SERVER queen 807f1041 1800
VENDOR alterad "/opt/altera/quartus80/solaris/alterad"
USE_SERVER
FEATURE altera_mainwin alterad 2008.12 permanent 5 391A92407D4B SIGN="0191 120C \ 

BB64 BC39 E5C8 EBBB 7894 E064 D348 61CC 5C6F 16DD 1269 F246 D07E 19C8 CAE3 \ 
E3E3 6965 E38D 1452 BB74 20E9 E6F6 5718 89AC 0E23 B5B2 1581 E453"

FEATURE quartus alterad 2008.12 permanent 5 7A496B23A403 SIGN="1C66 DAC6 1DAB C886 \ 
727B 65DF FAC2 B479 3E3C 656D 3561 E5D0 BBA3 C45C 4DDC 0F2F 68F5 4DF1 6F63 \ 
7785 2F5D 1480 1B0A 70DE 2220 1952 DDCD 9F4D 6D61 A177"

Optional port 
number

Server 
name

Server 
host ID 
number

Daemon 
name

Release 
date

Expiration 
date

Feature 
name

Number of 
licenses 
requested

Authorization 
code
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Modifying the License File
The license.dat file must be modified before it can be used by the license 
server.

.

The first few lines of the license file are shown in the following example 
(your license file may not contain all the VENDOR entries, depending on 
which software you have enabled):

SERVER <host name> <8- or 12-character host or NIC ID> <port number>
VENDOR alterad "<path to daemon executable>"
VENDOR mgcld "<path to daemon executable>"

To modify the license file, follow these steps:

1. In the license.dat file, type the variables that are described in Table 1. 
The host or NIC ID will already be entered in the license file.

2. Ensure the license file meets the following guidelines:

– The license file name must have a .dat extension. If your text editor 
adds .txt or another extension to the file name, such as 
license.dat.txt, you must rename the file to have only a .dat 
extension.

– The license file must have a carriage return at the end of the last 
FEATURE line.

– Any FEATURE line that wraps to a second or third line must 
contain a backslash (\) at the end of the line to indicate that it 
continues.

! Node-Locked (Single-User) License

If you have a node-locked (single-user) license, you can skip this section and go to 
“Starting the Quartus II Software” on page 29.
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Table 1. Variables to Modify in the License File (license.dat) 

Variable Name Description Directory

<host name> The host name of the server; for example, my_server.

<port number> 
(1)

The port number for the license manager service on the server; for 
example, 1800. The port number is optional and should be different 
from the port number for any other service on the machine.

alterad "<path 
to daemon 
executable>" 
(2)(3)

Path to the Altera vendor 
daemon executable 
alterad.

Solaris: /<Quartus II system directory>/
solaris/alterad
Linux: /<Quartus II system directory>/
linux/alterad

mgcld "<path to 
daemon 
executable>" 
(2)(3)(4)

Path to the Mentor 
Graphics vendor 
daemon executable 
mgcld.

Solaris: /<ModelSim-Altera system 
directory>/sunos5aloem/mgls/lib/
mgcld
Linux:/<ModelSim-Altera system 
directory>/linuxaloem/mgls/lib/
mgcld

Notes:
(1) To prevent port number conflicts, you can specify a port number in the license file. If you do not 

specify a port number, the FLEXlm License Manager automatically chooses a free port between 
27000 and 27009. If three redundant servers are in use, you must specify a port number greater 
than 1024. Port numbers less than 1024 are privileged port numbers on UNIX servers.

(2) In some network environments, the license server does not have a software tool(s) installation 
that provides the necessary vendor daemon (alterad or mgcld). In this case, copy the required 
daemon from another machine that does have an installation of the software. Find the file in the 
directory location specified. Save the file in a similarly named directory or any other location on 
the license server. Specify the daemon location on the license server in the license file.

(3) If the path server has spaces in it, enclose the full path in quotation marks.
(4) If you are not using a license file for the ModelSim-Altera software, you may delete this line.

f For Information About Refer To

The license file and modifying the 
license file for the Quartus II and 
MAX+PLUS II software and for other 
EDA tools

AN 340: Altera Software Licensing, which is 
available from the Literature section of the 
Altera website at www.altera.com/
literature
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Upgrading or Setting Up a License 
Manager Server

This section provides instructions for configuring network licensing for the 
Quartus II software on Sun Ultra workstations running Solaris 8 or 9, or Intel 
Pentium III or compatible processor-based Linux workstations running Red 
Hat Enterprise Linux 3.0 or 4.0 or SUSE Linux Enterprise Server 9.

Upgrading the FLEXlm License Server 
Software

To support network licensing, the Quartus II software requires the FLEXlm 
License Manager server software version 8.0 or later. The installation script 
automatically installs version 9.5 of the FLEXlm License Manager server 
software on Solaris and Linux workstations, but you should also verify that 
the version of the FLEXlm License Manager software or the license server 
software is 8.0 or later. If the FLEXlm License Manager software is version 
8.0 or later, skip to “Rereading an Existing UNIX or Linux Workstation 
License File” on page 22.

v To determine which version of the FLEXlm License Manager server 
software you are using, type the following command at a command 
prompt on the computer running the FLEXlm License Manager server 
software: 

/<FLEXlm system directory path>/lmgrd -v r
/<FLEXlm system directory path>/alterad -v r

If the lmgrd or alterad daemons are not from the FLEXlm software version 
8.0 or later, you must upgrade both daemons with the versions provided in 
the installation of the Quartus II software.

To upgrade an older version of the FLEXlm License Manager server 
software, follow these steps:

1. Make a backup copy your current lmgrd and alterad daemons.

2. Copy the new versions of the files to the computer running the license 
server over your current daemons. You may have to shut down the 
license server software to complete this step.
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If you installed the FLEXlm License Manager server software using the 
installation script, the current version of the lmgrd and alterad 
daemons are located in the following directories:

/<Quartus II system directory>/<operating system name>/alterad
/<Quartus II system directory>/<operating system name>/lmgrd

where <operating system name> can be solaris or linux.

3. Copy the FLEXlm software utility lmutil from the Quartus II system 
directory to the license server computer.

4. Restart the FLEXlm license server by typing the following commands 
at a command prompt:

/<FLEXlm system directory path>/lmutil -c lmdown <license file 
path> r

/<FLEXlm system directory path>/lmgrd -c <license file path>
[-l <optional log path>] r

Rereading an Existing UNIX or Linux 
Workstation License File

The Quartus II software uses the FLEXlm software to administer licensing 
for single or multiple users in a network installation. If you have an existing 
FLEXlm license server with an existing license file for the MAX+PLUS II 
software or software from another vendor, and the FLEXlm license server is 
version 8.0 or later, you can copy and paste the Altera FEATURE lines from 
your Quartus II license.dat file into your existing license file. Paste the 
Quartus II FEATURE line as shown in the sample license file in Figure 1 on 
page 17. Make sure you have also modified the license file according to the 
guidelines in “Modifying the License File” on page 19.

If you make these changes to your license file, you must reread the license 
file or restart the license server before you can run the Quartus II software 
for the first time. 

Refer to “Upgrading the FLEXlm License Server Software” on page 21 to 
verify that you are using the latest supported version of the FLEXlm License 
Server software, or if you need to upgrade an older version of the FLEXlm 
License Server software.
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v To reread your license file on a license server, type the following 
command at a command prompt:

/<Quartus II system directory>/<operating system name>/lmutil 
lmreread r

where <operating system name> can be solaris or linux.

or

Restart the license server.

Configuring a New UNIX or Linux 
Workstation License Server

The Quartus II software uses the FLEXlm software to administer licensing 
for single or multiple users in a network installation. If you do not have an 
existing FLEXlm license server, you must configure a new Solaris or Linux 
license server before starting the Quartus II software for the first time.

You should be aware of the following information before you configure a 
new license server:

■ If you have an existing FLEXlm license server, refer to “Rereading an 
Existing UNIX or Linux Workstation License File” on page 22.

■ Ensure you obtained a valid license file according to the guidelines in 
“Obtaining a License File” on page 15, and that you modified the 
license file according to the guidelines in “Modifying the License File” 
on page 19.

■ These instructions assume that you have installed the license.dat file in 
the /usr/local/flexlm/licenses directory. If you have installed the 
license file in a different directory, substitute the appropriate path 
name for that directory.

! Configuring a New License Server

If you do not have an existing FLEXlm license server, and you need to configure a 
new license server, skip to “Configuring a New UNIX or Linux Workstation License 
Server” on page 23.
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v To configure a new license server, type the following command at a 
command prompt:

/<Quartus II system directory>/<operating system name>/lmgrd -c 
/usr/local/flexlm/licenses/license.dat r

where <operating system name> can be solaris or linux.

Installing the FLEXlm Software on 
Another License Server

You can install the FLEXlm software on an additional Solaris or Linux 
license server.

To install the FLEXlm software on another license server, perform the 
following steps:

1. Create a directory named /<Quartus II system directory>/
<operating system name> on the additional license server, where 
<operating system name> can be solaris or linux.

2. Copy the following files from the /<Quartus II system directory>/
<operating system name> directory of your original Quartus II 
software into the new /<Quartus II system directory>/
<operating system name> directory:

– lmgrd
– lmutil
– alterad

f For Information About Refer To

Configuring a new UNIX workstation 
license server

readme.txt file, which is located in the 
Quartus II system directory or the top level 
directory of the Altera Complete Design 
Suite DVD-ROM
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Configuring Each Workstation
Before starting the Quartus II software for the first time, you must configure 
each UNIX or Linux workstation that will run the Quartus II software.

Configuring Each Solaris Workstation

For each Sun Solaris UNIX workstation that will run the Quartus II software, 
you must verify the required runtime patches and kernel configuration 
before starting the Quartus II software for the first time.

Verifying Required Runtime Patches (Solaris 8 
Only)

Make sure that each workstation has the runtime and graphics card patches 
that are required to run the Quartus II software on a Solaris 8 UNIX 
workstation. The last two numbers of the patches represent the version 
number and can be substituted with a more recent version number. Refer to 
Table 2 for a list of patches and descriptions.

v To determine which patch is installed on your system, type the 
following command at a command prompt:

showrev -a | grep <patch number> r

If the patches are not installed on your system, you should download the 
appropriate replacement patch from the Sun Microsystems support website 
at sunsolve.sun.com. Altera recommends checking the Support Center 
section of the Altera website at www.altera.com for late-breaking 
information on required and optional operating system patches. In addition, 
the latest version of this manual, the Quartus II Installation & Licensing for 

! Before You Configure a Solaris Workstation

You should be aware of the following information before you configure a Solaris 
workstation:

■ You must have superuser or “root” privileges to install runtime patches or 
modify kernel configuration.

■ Solaris 9 workstations do not require runtime patches.
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UNIX and Linux Workstations manual, which is available in PDF format from 
the Altera website at www.altera.com/literature, may contain updated 
information on patches.

Table 2 lists the runtime patches for Solaris 8.

Verifying Kernel Configuration (Solaris Only)

If necessary, perform the following steps on a UNIX workstation running 
Solaris 8 or 9 to ensure that the system’s kernel configuration meets the 
minimum system requirements to run the Quartus II software.

1. Verify the configuration parameters listed in Table 3 to ensure that the 
values listed in the system file, which is located in the etc directory, are 
greater than or equal to the recommended values listed in Table 3.

2. If one or more of the parameters do not have the recommended values, 
change the values to the recommended values by adding one or more 
of the following lines to the /etc/system file:

set pt_cnt=200

Table 2. Solaris 8 Runtime Patches

Runtime Patches Description Reason for Patch

109147-12 or later SunOS 5.8 Linker 
patch

Correct dynamic load and unload of 
shared libraries

Note: If you are unable to install this runtime patch, the Quartus II software still functions, but online 
Help is not available and the graphical user interface performance and general stability may be 
affected.

Table 3. Solaris Configuration Parameters

Solaris Parameter Recommended Value

pt_cnt 200

shmmax 8388608

shmmni 1000

shmseg 16
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set shmsys:shminfo_shmmax=8388608
set shmsys:shminfo_shmmni=1000
set shmsys:shminfo_shmseg=16

3. Restart the workstation.

Configuring Each Linux Workstation

For each Linux workstation that will run the Quartus II software, you must 
verify the libraries and kernel configuration before starting the Quartus II 
software for the first time.

Verifying Required Libraries (Linux Only)

To use the Visual MainWin software, which is required to run the Quartus II 
software on Linux workstations, the Linux workstation requires the GNU 
libc libraries (glibc). Table 4 lists the glibc versions required for each version 
of Linux supported by the Quartus II software.

The GNU libc libraries are available at the Red Hat Linux website at 
www.redhat.com.

! Before You Configure Each Linux Workstation

You must have superuser or “root” privileges to install runtime patches or modify 
kernel configuration.

Table 4. Required glibc Version for Linux Workstations

Red Hat Linux Version glibc Version

Red Hat Linux Enterprise 3.0 glibc 2.3.2-95

Red Hat Linux Enterprise 4.0 glibc 2.3.4-2

SUSE Linux Enterprise Server 9 glibc 2.3.3-98
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Verifying Kernel Configuration (Linux Only)

You should perform the following steps to ensure that the system’s kernel 
configuration meets the minimum system requirements to run the 
Quartus II software:

1. Check the configuration parameters listed below to make sure that the 
values listed in the limits.conf file, which is located in the /etc directory, 
are greater than or equal to the recommended values listed in Table 5.

2. If the parameters do not have the recommended values, change the 
values to the recommended values by adding one or more of the 
following lines to the limits.conf file:

 

3. Type the following command at the command prompt:

echo 356 40000 32 32000 > /proc/sys/kernel/sem r

Table 5. Linux Configuration Parameters

Linux Parameter Recommended Value

hard nofile 32768

soft nofile 32768

! Asterisks (*) in limits.conf File

The asterisks (*) in the previous lines are part of the code and must be 
included in the limits.conf file.

! Adding Kernel Configuration Command to Linux Workstation 
Startup Scripts

The previous command takes effect immediately; however, Altera 
recommends that your system administrator also add the commands to the 
workstation’s startup scripts, because the command is reset whenever you 
restart the workstation.
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Configuring Each User Environment
Ensure that you perform the following steps for each Quartus II software 
user before starting the Quartus II software for the first time:

1. Update each user’s PATH environment variable in the .cshrc file, which 
is located in the home directory, to include the bin directory in the 
Quartus II system directory, which is usually the /opt/altera/
quartus<version number>/bin directory. To update the PATH 
environment variable, type the following command at a command 
prompt:

setenv PATH ${PATH}:/<Quartus II system directory>/bin r

2. Save the changes to the .cshrc file, and then type the following 
commands at a command prompt:

cd r
source .cshrc r

Starting the Quartus II Software
After you have followed all the guidelines for configuring each workstation 
and each user environment, you can start the Quartus II software by typing 
the following command at a command prompt:

quartus r

When you start the Quartus II software, if a valid license file cannot be 
detected, the software prompts you to specify a valid license file.

! Avoid Starting the Quartus II Software from Platform-Specific 
Directories

Make sure you do not start the quartus command in the /<Quartus II system 
directory>/<operating system name> directory (for example, the /<Quartus II 
system directory>/linux directory or the /<Quartus II system directory>/
solaris directory). If you start the Quartus II software in a platform-specific 
directory, the software may not function correctly. For more information, refer to 
“Configuring Each User Environment” on page 29.
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If you want to enable the Internet connectivity features of the Quartus II 
software, you should also follow the guidelines in “Specifying a Web 
Browser” on page 34.

Specifying the License File
Once you have obtained a license file and set up a license server, you must 
specify the location of the license file for each user (or “client”). You can 
specify the license file with either of the following methods, which are 
described in more detail in this section:

■ Specify the license file with the Quartus II software

■ Specify the license file with the .cshrc file on client workstations

Specifying the License File within the 
Quartus II Software

To specify the license file within the Quartus II software, follow these steps 
on each workstation that will be running the Quartus II software:

1. If you have not already done so, start the Quartus II software, as 
described in “Starting the Quartus II Software” on page 29.

! Specifying the License File with the ModelSim-Altera Software and 
MAX+PLUS II Software

If you are using the Altera-provided ModelSim-Altera simulation software, which is 
included with Altera software subscriptions, and/or you are using the MAX+PLUS II 
software, you should specify the license file with the .cshrc file.

! Starting the Quartus II Software for the First Time

When you start the Quartus II software, if the software cannot detect a valid 
license file, you are asked whether you want to run in evaluation mode for 
30 days, request a free renewable 150-day license file from the Altera website, 
or specify the correct location of a valid license file.
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2. Select If you have a valid license file, specify the location of your 
license file. The License Setup page of the Options dialog box is 
displayed. Figure 4 shows the License Setup page.

or

If you want to specify the license file later, click License Setup on the 
Tools menu. The License Setup page appears.

Figure 4. License Setup Page of the Options Dialog Box

Current license Option to use LM_LICENSE_FILE variable License file location Web License Update button

Local system 
information

Begin 30-day Grace 
Period button

Licensed AMPP/
MegaCore functions
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3. In the License file box, specify the full path name of the license.dat file, 
or browse to locate the license.dat file. Altera recommends that you 
store the license.dat file in a directory named 
/usr/local/flexlm/licenses.

You can also specify the location of the license file by typing a name of 
the format <port>@<host> instead of a license file path name, where 
<host> is the name of the server where the license file is stored and 
<port> is the port listed in the license.dat file. See Figure 1 on page 17 
for a sample network license file to determine your port and server 
name, and refer to Table 1 on page 20 for more information about port 
numbers. If there is no port listed in the license.dat file, you can simply 
specify @<host>.

If you want to use the current LM_LICENSE_FILE value specified in 
the .cshrc file, turn on Use LM_LICENSE_FILE variable.

4. If you want to check the Altera website for license file updates, click 
Web License Update.

5. If you want to use the Quartus II software in the “Subscription 
Expiration” grace period, click Begin 30-day Grace Period. The 
“Subscription Expiration” grace period allows you to use the Quartus II 
software with programming file support for 30 days. When the grace 
period expires, you must obtain an updated license file at the Altera 
website to continue using the Quartus II software with programming 
file support.

6. Click OK.

The Licensed AMPP/MegaCore functions list of the License Setup page 
lists all of the features and products that are available for the license.

! Specifying Multiple License Files and/or Servers

If you have more than one license file or server, separate the port and host 
specifications with colons (:), with no spaces between the names and 
numbers. For example:

1800@king:/usr/local/lib/license.dat:270000@queen
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Specifying the License File in the 
.cshrc File on Client UNIX and Linux 
Workstations

To specify the license file in the .cshrc file on each client (user) workstation, 
make sure that you update the LM_LICENSE_FILE variable that is specified 
in the .cshrc file located in each user’s home directory. You must edit this file 
for each user, or provide clear instructions that describe which lines the user 
needs to enter or edit:

v Make sure that each user has an LM_LICENSE_FILE variable that is 
set to the full directory path name of the license file. To update this 
variable, add the following line to the .cshrc file for each user:

setenv LM_LICENSE_FILE /usr/local/flexlm/licenses/
license.dat

or

If you want to specify the name of the server on which the license file is 
stored, add the following line to the .cshrc file for each user:

setenv LM_LICENSE_FILE <port>@<host>

where <host> is the name of the server and <port> is the port listed in 
the license.dat file. See Figure 1 on page 17 for a sample network 
license file to determine your port and server name, and refer to Table 1 
on page 20 for more information about port numbers. If there is no port 
listed in the license.dat file, you can simply specify @<host>.

! Using the setenv Environment Variable with Multiple 
Applications

If more than one application uses this environment variable, separate the 
different paths with a colon (:) with no spaces between the path names. For 
example:

setenv LM_LICENSE_FILE /usr/local/flexlm licenses/license.dat:/
tmp/license.xyz
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If you want the Quartus II software to use the LM_LICENSE_FILE setting 
from your .cshrc file, make sure Use LM_LICENSE_FILE variable is turned 
on in the License Setup page of the Options dialog box.

Specifying a Web Browser

You must specify your web browser location in the Options dialog box to 
enable the Internet connectivity features of the Quartus II software. To 
specify your web browser location, follow these steps:

1. Start the Quartus II software.

2. On the Tools menu, click Options.

3. In the Category list, select Internet Connectivity. The Internet 
Connectivity page appears.

4. In the Web browser box, specify the full path name of your web 
browser. 

5. If you are using a proxy server, specify the proxy address and port by 
performing the following steps:

a. Turn on Access the web using a proxy server.

b. In the Address box, type the proxy address or host name.

c. In the Port box, type the port number.

d. In the User name box, type the user name if required.

e. In the Password box, type the password if required.

6. Click OK.

! Using the setenv Environment Variable with Multiple 
Applications

If you have more than one license file or server, separate the port and host 
specifications with colons (:), with no spaces between the names and 
numbers. For example:

1800@king:/usr/local/lib/license.dat:270000@queen
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Figure 5. Internet Connectivity Page of the Options Dialog Box

Web browser location

User name Password

Port number

Proxy address
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Registering for an Altera.com Account

Your copy of the Quartus II software is registered at the time of purchase; 
however, in order to use the mySupport website to view and submit service 
requests, you must also register for an Altera.com account and an Altera 
user name. You can use your Altera user name to access your Altera.com 
account. Although use of the mySupport website requires you to have an 
Altera.com account, this account also makes it easier to use many other 
Altera website features, such as the Download Center, Licensing Center, 
Altera Technical Training online class registration, or Buy On-Line-Altera 
eStore features.

To register for an Altera.com account, follow these steps:

1. Go to the mySupport website:

To start your web browser and connect to the mySupport website while 
running the Quartus II software, on the Help menu, point to Altera on 
the Web, and then click Quartus II Service Request.

or

Point your web browser to the mySupport website at www.altera.com/
mysupport.

2. Follow the instructions on the mySupport website to register for an 
Altera.com account.

If you are not a current Altera subscription user, you can still register for an 
Altera.com account.

Licensing Related Software
In addition to licensing the Quartus II software, you must also license any 
other related Altera software you install. This section contains licensing 
procedures for the MegaCore IP Library, Nios II Embedded Design Suite, 
and ModelSim-Altera software. 
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MegaCore IP Library

Once you purchase a license for any of the IP cores, you can request a license 
file from the Licensing section of the Altera website at www.altera.com/
licensing and install it on your computer.

If you have already installed a license for an IP core, and then you receive a 
new license file for a new IP core, you can either append the license file to 
your existing license.dat file, or you can specify the IP core’s license.dat file 
in the Quartus II software.

Nios II Embedded Design Suite

You can create, compile, and generate time-limited FPGA programming 
files for Nios II hardware systems without obtaining a license file. To 
generate non-time-limited FPGA programming files and flash 
programming files, you must obtain a license for the Nios II processor core 
in addition to the license for the Quartus II software. You do not need a 
license to develop software using only the Nios II IDE.

ModelSim-Altera

You can request a ModelSim-Altera license file from the Licensing section of 
the Altera website at www.altera.com/licensing and install it on your 
computer.

The ModelSim-Altera software supports licenses using the Mentor Graphics 
license daemon mgcld. You can find the mgcld daemon in the following 
directories:

■ For Solaris Workstations:

<modelsim-altera installation dir>/sunos5aloem

or

<Quartus II system directory>/solaris/sunos5aloem (when installed 
using the Altera Complete Design Suite for UNIX and Linux 
DVD-ROM)
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■ For Linux Workstations:

<modelsim-altera installation dir>/linuxaloem

or

<Quartus II system directory>/linux/linuxaloem (when installed 
using the Altera Complete Design Suite for UNIX and Linux 
DVD-ROM)

Before starting the ModelSim-Altera software, you must set your 
ModelSim-Altera LM_LICENSE_FILE environment variable to the location 
and filename of the ModelSim-Altera license file. For example, the 
ModelSim-Altera LM_LICENSE_FILE environment variable should be set 
to the location and file name of your license file (<modelsim-altera 
installation dir>/licenses/eda/license.dat) or with the port@host notation 
(1900@set). Refer to “Setting Environment Variables” on page 40.
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Introduction
This section describes how to change additional workstation configuration 
items including Quartus II general environment variables, Quartus II 
NativeLink® environment variables, user names, language settings, and 
fonts.

Setting Environment Variables
This section describes the environment variables that the Quartus II 
software uses to configure various options and locate files.

If you are using the C shell, environment variables are located in your .cshrc 
file, and have the following format:

setenv <environment variable> <value>

If you are using the Bourne or Korn shell, environment variables are located 
in your .profile file, and have the following format:

set <environment variable> = <value>

Quartus II General Environment 
Variables

The Quartus II software installation process initializes the following 
variables, but you may wish to change them to optimize your system 
performance.

QUARTUS_ROOTDIR

The QUARTUS_ROOTDIR variable specifies the name of the Quartus II 
system directory. The default directory is /opt/altera/quartus<version 
number>. You should change this variable only if the system displays an 
error message indicating that Quartus II files cannot be found when you 
start the program.
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MWFONT_CACHE_DIR

The MWFONT_CACHE_DIR variable specifies the name of the Quartus II font 
cache directory. The default directory is /<user’s home directory>/.mw.

QUARTUS_MWWM

The QUARTUS_MWWM variable specifies how the Quartus II software should 
interact with the system’s window manager. By default, the QUARTUS_MWWM 
environment variable is set to allwm (except for Linux workstations) and 
the Quartus II software operates normally with all supported window 
managers (refer to “Quartus II Software System Requirements” on page 2 
for a list of supported window managers). If you are not using one of the 
default window managers, make sure you set the QUARTUS_MWWM 
environment variable to allwm to allow the Quartus II software to 
determine the most compatible mode.

QUARTUS_64BIT

The QUARTUS_64BIT variable specifies the 64-bit version of the Quartus II 
software. To turn on 64-bit processing in the Quartus II software, set the 
environment variable to 1 before running the Quartus II software. This 
variable is supported only in systems with 64-bit processing.

QUARTUS_LIBRARY_PATHS

The QUARTUS_LIBRARY_PATHS variable specifies user-defined library 
paths. You can use this environment variable to define multiple library 
paths at the same time instead of manually adding each path to the user 
library individually.

Quartus II NativeLink Environment 
Variables

The Quartus II software installation process initializes the following 
variables, but you must set them to use the NativeLink features of the 
Quartus II software.
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QUARTUS_INIT_PATH

The QUARTUS_INIT_PATH variable specifies the path(s) of the EDA tool(s) 
to be launched from within the Quartus II software. You must set this 
variable to launch other EDA tools from within the Quartus II software.

QUARTUS_INIT_LIBPATH

The QUARTUS_INIT_LIBPATH specifies the LD_LIBRARY_PATH variable 
needed by some EDA tools. You should set this variable to the EDA tool’s 
LD_LIBRARY_PATH if the EDA tool requires an LD_LIBRARY_PATH 
variable.

Other Workstation Configuration 
Information

This section describes other workstation configuration information, 
including user names, language settings, fonts, printers, and 64-bit 
processing:

■ If you want to change user names at a workstation using the su 
command, you must type the following command at the command 
prompt before starting the Quartus II software:

su - <username> r

Changing user names using the su <username> command (without the 
dash) causes the new user to use the environment settings from the 
previous user, which may cause the Quartus II software to stop 
responding.

■ The Quartus II software does not support UNIX language settings 
other than English. The LANG variable must be set to C for the 
Quartus II software to function correctly.

■ By default, generated fonts are saved to the /<user home directory>
/.mw directory; however, having the font cache saved to these 
directories for each user may cause unnecessary duplication of fonts. 
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You can avoid this problem by specifying a directory to contain all the 
generated fonts for the display. To specify this directory, type the 
following command at the command prompt:

setenv MWFONT_CACHE <new directory name> r

■ If the Quartus II software stops responding due to an internal error, 
determine whether any of the following processes are running:

You can determine which processes are running by typing the 
following command at the command prompt:

/usr/bin/ps -ef r

You must then terminate these processes by typing the following 
command at the command prompt:

kill -9 <process ID number> r

■ You can use the mwcleanup utility to clean up system resources and 
terminate all MainWin applications by typing the following command 
at the command prompt:

mwcleanup r

■ You can enable 64-bit processing by passing the --64bit option to the 
quartus_map, quartus_fit, quartus_sta, quartus_tan, and/or 
quartus_cdb executables. For example, you can enable 64-bit 
processing with the quartus_map executable by typing the following at 
the command prompt:

quartus_map --64bit r

The --64bit option is supported in systems with 64-bit processing 
only.

mwrpcss quartus_sim
quartus quartus_pow
quartus_map quartus_stp
quartus_fit quartus_pgm
quartus_tan quartus_cpf
quartus_asm quartus_sh
quartus_drc quartus_cmd
quartus_cdb quartus_sta
quartus_eda
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Starting the Quartus II Interactive 
Tutorial

The Quartus II software includes the Flash-based Quartus II Interactive 
Tutorial. The modules of this tutorial teach you how to use the basic features 
of the Quartus II design software, including design entry, compilation, 
timing analysis, simulation, programming, and advanced topics.

This tutorial includes audio and Flash animation components. For best 
results, use the tutorial on a system that includes a sound card, speakers, and 
at least 1024x768 display resolution.

To start the Quartus II tutorial after you have successfully installed the 
Quartus II software:

v On the Help menu, click Tutorial.

Once you start the tutorial, you can jump immediately to any tutorial 
module by clicking Contents. Once you select a tutorial module, you can 
click ShowMe, GuideMe, or TestMe at any time to jump directly to the 
tutorial mode that best suits your learning style.

Your system must meet the requirements described in the “Quartus II 
Software System Requirements” on page 2 to run the tutorial.

Using Quartus II Help
The Quartus II software includes a platform-independent Help system that 
provides comprehensive documentation for the Quartus II software and 
more details about the specific messages generated by the Quartus II 
software. You can view Help in one of the following ways:

■ Press F1 from a highlighted menu command or active dialog box for 
context-sensitive Help.

■ Press Shift+F1 or click Context-Sensitive Help  on the toolbar. The 
pointer turns into a Help pointer. You can then point to a menu 
command or active window and click for context-sensitive Help.

■ On the Help menu, click any of the following commands:
– Index: The Index lets you search for and display all Help topics 

related to a keyword or phrase.
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– Search: The Search finds a maximum of 500 topics containing the 
search keyword.

– Contents: The Contents outlines the design flow and groups 
related topics into folders, but does not list all the topics in 
Quartus II Help.

– Messages: The Messages list provides an alphabetical list of all 
messages and offers detailed Help on each message. To view Help 
on an individual message, in the Messages window, right-click the 
message on which you want to receive Help, and then click Help.

– Glossary: The Glossary list provides definitions to key 
terminology in the Quartus II software.

Contacting Altera
You can contact Altera for technical support and product information.

f For Information About Refer To

Using Quartus II Help “Help Menu Commands” in Quartus II Help

“Using Quartus II Help Effectively” in 
Quartus II Help

Table 1. Quartus II Technical Support Resources

Resource Description

Altera website: www.altera.com

mySupport website: www.altera.com/mysupport

Or, on the Help menu, point to Altera on the Web, and then 
click Quartus II Service Request in the Quartus II software. 
This website allows you to submit, view, and update technical 
support service requests.

Telephone: (800) 800-EPLD
(7:00 a.m. to 5:00 p.m. Pacific time, M–F) You will need your 
6-digit Altera ID to access the hotline.

(408) 544-8767
(7:00 a.m. to 5:00 p.m. Pacific time, M–F)
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Product Information

If you need the latest Altera product information or literature, go to the 
Literature section of the Altera website at www.altera.com/literature.

! Registering for an Altera.com Account

In order to use the mySupport website to view and submit service requests, you 
must also register for an Altera.com account. An Altera.com account is required only 
for using the mySupport website; however, having an Altera.com account will also 
make it easier for you to use many other Altera website features, such as the 
Download Center, Licensing Center, Altera Technical Training online class 
registration, or Buy On-Line-Altera eStore features. For more information, refer to 
“Registering for an Altera.com Account” on page 36 in Chapter 2, “Licensing the 
Quartus II Software.”

f For Information About Refer To

 Altera technical support services The Contact Altera section of the Altera 
website
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Quartus II Software and Related 
Software File Organization

During the Quartus II software and related software installation, one 
top-level directory is created:

The /opt/altera<version number> directory (the main directory where 
the Quartus II software files are installed) contains system software and 
data files and includes the subdirectories shown in Figures 1 and 2.

The /opt/altera<version number> directory includes the subdirectories listed 
and data files shown in Figure 1.

Figure 1. Altera Software System Directory (/opt/altera <version 
number>)

/opt/altera<version number>

modelsim_aenios2eds

common
crc_compiler
ddr
nios2_ip
pci_compiler
pci_express_compiler
rapidio
seriall ite_ii
...

bin
components
documents
examples
sdk2
...

docs
drivers
examples
verilog
vhdl
...

quartus ip
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The /opt/altera<version number>/quartus directory includes the 
subdirectories and data files shown in Figure 2.

Figure 2. Quartus II Software System Directory (/opt/altera <version 
number>/quartus)

/opt/altera<version number>/quartus

fv_lib

innoveda

synopsys

mentor

ibis

cadence

vhdl93

vhdl87

software

primitives

other

megafunctions

tutorials

documents

examples

placeholders

components

europa

bin

bin cusp linux lmf qdesigns solaris64

misc

tcl

ip

help

flow

devinfo

advisors

common

cusp

adm eda libraries linux64 mw solaris

stingray

sopc_builder

fir_filter
.. .
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Introduction
This appendix describes how to mount and unmount the Altera Complete 
Design Suite DVD-ROM on UNIX and Linux workstations.

Mounting and Unmounting 
DVD-ROMs on Solaris Workstations

To mount a DVD-ROM on a Solaris workstation, follow these steps:

1. Specify the directory where you want to mount the DVD-ROM drive. 
The DVD-ROM drive is usually placed in the top-level directory. To 
access this directory, type the following command at the command 
prompt:

dvd/ r

2. To create the /dvdrom/dvdrom0 directory, type the following 
command at the command prompt:

mkdir /dvdrom/dvdrom0 r

3. If you have not already done so, insert the DVD-ROM into your 
DVD-ROM drive.

4. To mount the DVD-ROM drive, type the following command at the 
command prompt:

/sbin/mount -F hsfs -o ro /dev/dsk/
<device name of DVD-ROM> /dvdrom/dvdrom0 r

! Before You Mount a DVD-ROM

You must have superuser or “root” privileges to mount and unmount the DVD-ROM 
drive. If you are running Volume Manager, the DVD-ROM drive is mounted and 
unmounted automatically as /dvdrom/dvdrom0 (you do not need to have root 
privileges to mount a DVD-ROM with the Volume Manager), and you do not need to 
perform the mounting and unmounting procedures. 
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If you have previously mounted and unmounted this DVD-ROM, a 
number may be appended to the device name of the DVD-ROM, in 
which case you should use the complete name and number for 
<device name of DVD-ROM>. For example, if the device name appears 
as modelsim, use that name.

To unmount a DVD-ROM on a Solaris workstation, follow this step:

v To unmount the DVD-ROM drive, type the following command at the 
command prompt:

/sbin/umount /dvdrom/dvdrom0 r

To successfully unmount the DVD-ROM drive, you must make sure no 
one is accessing the directory structure at or below the dvdrom 
directory. If another user is using the DVD-ROM drive, you may 
receive the following message:

umount: cannot unmount /dvdrom/dvdrom0: Device busy

To determine whether you are accessing the DVD-ROM drive yourself, 
type the following command at the command prompt:

pwd r

You should see the / prompt on your screen. If you do not, you should 
type dvd/ r again.

Mounting and Unmounting 
DVD-ROMs on Linux Workstations

! Before You Mount a DVD-ROM

You must have superuser or “root” privileges to mount and unmount the DVD-ROM 
drive. If you are logged in on a console, you do not need to have root privileges to 
mount a DVD-ROM.
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To mount a DVD-ROM on a Linux workstation, follow these steps:

1. If the /mnt/dvdrom directory does not exist, type the following 
command at the command prompt:

mkdir /mnt/dvdrom r

2. If you have not already done so, insert the DVD-ROM into your 
DVD-ROM drive.

3. To mount the DVD-ROM drive, type the following command at the 
command prompt:

/bin/mount /mnt/dvdrom r

If you have previously mounted and unmounted this DVD-ROM, a 
number may be appended to the device name of the DVD-ROM, in 
which case you should use the complete name and number for 
<device name of DVD-ROM>. For example, if the device name appears 
as modelsim, use that name.

To unmount a DVD-ROM on a Linux workstation, follow this step:

v To unmount the DVD-ROM drive, type the following command at the 
command prompt:

/bin/umount /mnt/dvdrom r

To successfully unmount the DVD-ROM drive, you must make sure 
that no one is accessing the directory structure at or below the dvdrom 
directory. If another user is using the DVD-ROM drive, you may 
receive the following message:

umount:/mnt/dvdrom : Device busy

To determine whether you are accessing the DVD-ROM drive yourself, 
type the following command at the command prompt:

pwd r

You should see the / prompt on your screen. If you do not, you should 
type dvd/ r again.
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